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Abstract

This project is concerned whit the studies and development in robot production used in
Thailand Robo Cup Championship Junior held annually which focuses on initiating the
international research and study supporting artificial intelligence and intelligent robot research.
Thailand Robo Cup Championship uses football game as a criterion in this competition in order to
make the robots be able to work property in the football game. The researcher has to combine
various kinds of technology including producing robot in limited area, co-working among robot,
fighting strategies and logical thinking that leads move rapidly under the ever changing situation.

This project is divided into two parts. The first part is about the robot appearance which
is designed and developed from general robot. The second one is about the software used in robot
controlling and digital image processing which developed by Open CV Library and Microsoft

Visual Studio 6.0 C++ uses image processing by Global Vision.
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3.2.2 HBIMDIVLIADDY (Actuators)
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d
walmvInNITUaNIg (DC Motor)
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3.2.3 lulnsnenulns 1mes (Microcontroller)

1 o 1 = v { o ] o

ruoudvziiia b ldawi Tdsunsu 1l in bifiauesinugumsiauvesyuoud

3
4 =

Tulasesnuilld lulnsaounsweinszga Pic Faldnwnudn lums@eullsunsuadungy
' ¢ we ¢ A gl ot
Wuoud quiautidsuveslylasneuInsmeinszga pic Ao Whilulasnoulnsmoindoy

L4 1
Taol#nnlndRosnmuyyd lumsdouTsunsuatuguruoud

40-pin PICmicro® MCU Family

N/ 401 w—s REZIPGOKET3

MCLRAPPr —= [ 1 N
RAQAND wg—se [ 2 30 [0 -—= RBG/PGCKB12
RATANT -=—=[] 3 38 [ ~+—= RB&KBI1
RAZ/ANZNRUVREF- me—u= ] 4 37 [ ==—=- RB4/KBID
RAJ/ANINRHNVREF+ —t—te [ 5 36 [1=—= RB3I/PGM/CCP2/ICANRX
RAATOCKI =+—=[] G 35 [ =+—= RB2/INT2/CANTX
RARSS/ANHLVOIN =+—e-[ 7 34 [0 ~—= RBIINT
REQ/RD/AMNS —+—n-[] 8 33 [] -a—= REBWVINTO

-

RE1/WR/ANG -+—=-[] 0
REJCSIANT ~s—-[] 10
AVID —— [ 1 301 =—= RD7/PSP7/PD
AVss — [ 12 29 [1+s—w RDBPSPE/PC
DSCY/CLKI w13 28 [ -+—= RD5PSPHPA
OSC2/CLKORAS +—[ 14 27 [ -w—s= RD4/PSPAECCIPA
RCOMTOSOITIGKI ~a—ne[] 15 26 [] -a—s RCTIRX/OT
RG1T10SI/CCP2 wimis ] 16 25 [ =—a- RCB/TXICK
RC2CCP1 =+—[] 17 24 []-a—s= RCESKOD+
RCASCK/SCL -—w-[] 18 23 [ -s—w= RCA/SDI/SDAD-
RDOPSPUCH IN+ —p-[] 19 29 [] -4—n RD3PSPACIN-
RDA/PSP1/CT IN- ~—a=[T] 20 21 [t RD2/PSPC2IN+

32 0 «— Von
3N [0 =—Vss

40pin
PICmicros:
Family

PIC16CREG PIC18CTRES PIC18F4220
PIC16CG5B PIC16CT74 PIC18F4320
PICHGCET RIC16FB71 PIC18F4231
PIG16C662 PIC16Fa74 PIGTBF4431
FIC16CT4B PIC1GEF874A PIC18F442
PIC16CTT PIG1GFB7Y RPIC18F452
PIC16F74 PIC16FB7TA PIC18F448
PIC1EFT7 PIC18C442 PIC18F458
PIC12CA52

517 3.10 M3daGuINIFRyy Il YO PIC 40 Pin JUANY
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3.25 Nmmuqumma{ (Motor Driver)
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§ o ¢ A = o 1
M54 3.1 Mshaveswamosiilefloudunaludnuuzdieg

U Wi Tiua
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0 0 High — Impedance STOP
0 1 L H CwW/CCwW
1 0 H L CCW/CW
1 1 H H STOP
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(3792HIMIDBALUD MIAIVANIVININUARIY PIC 16F877 Controller A931/N 3.15
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5

”‘|!'“|

‘\n“m
|

Servo 1

1 Servo2 ||

L

5171 3.15 maifausde TA 7279 P/IAP fMuneimesaiq Taeld PIC 16F877 Aaugw




21
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§ 1 o
517 3.18 UoTamuguusuARIaSveNl)Talid

3.2.6 UUMIABSS (Battery)
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@ f=1

B = Tk, o 1 sy A 9 P o B
LUALABTT ﬂﬂ'J'llﬂuﬁ’JHﬁTﬂﬂlTIﬁWﬂﬁuﬂuﬂﬂ’ENIJ 114ﬂ'131‘})'!,!.'1.!ﬂlﬁﬂiﬁﬂziﬁllﬂﬁ!ﬂﬂi
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Vv 1
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¥ =~y
3.3 NARIINle (VDO Camera)
i aw o ' 1 ¢ o 1
diold yuweanvy Tnueaddulumsasiemdumiis voauoud duwiauea uag
o 1 ¢ v dqy oy da vad oy A a d ¥ da
dumisgilassn ndesnly szidlundesniigueniin Aeudeizasioa waziilundasiil
anmannsadenssvensdilefiszozanugeiigs Yszanm 400 ufines Tasndeshldly

¥ '
Tns3911Tiae OKAMI OK-6003 1/3” SONY HAD CCD Camera N15A11azoon 420 (&

mut’fﬁcl%’ﬁwm 2.8 mm. A 4.0 mm.

511 3.20 ndos OKAMI OK-6003

d 1
34 Qﬂﬂ'ﬁmmﬁﬁﬂm‘i (Communication Device)

d.’J 3 o U A wa o a 1 W
Tulassnuiildgasuds Bmoliguenid duatuing szesmsdaldlng

Uszana 1,0000m3 Tunsnuiilas uazanudnldegh 75 MHz 499 Futaba FP-R1380P
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3.5 TlsunsumuguyueudlaeliilszanananIn (Software Architecture)
351  Tdsupsuilszanananin (Robo Cup 2006 Project )
msthamvesTilsunsuludmdfosion  Tasfunmdundedelddiu - Buwe
g1 vt Tsunswezdnnnmfiia vosquouA voa uazglassn Uunw M3 g
1% OpenCyv Library uaz 1% Direct SDK lao %’aga;ﬂmwfu ﬂslﬁﬂiuﬁﬁikﬂiﬁéﬂﬁ Ipllmage*
Fufudaunlsyia  pomter  duihumedeynonaitdehilRnlacieglugvesdiiad
152001820 RGB color FatiuFaadran i Tavld fafu
HBITMAP CreateHBitmap(int w,int h, WORD bpp,int Size)
HBITMAP CreateHBitmap(int w,int h, WORD bpp,int Size)
{
HDC hDC = ::CreateCompatibleDC(0);
BYTE tmp[sizeof(BITMAPINFO)+255%4];
BITMAPINFO *bmi = (BITMAPINFO*)tmp;
HBITMAP hBmp;
inti;
memset(bmi,0,sizeof(BITMAPINFQ));
bmi->bmiHeader.biSize = sizeof(BITMAPINFOHEADER);
bmi->bmileader.biWidth = w;
bmi->bmiHeader.biHeight = h;
bmi->bmiHeader.biPlanes = (unsigned short)Size;
bmi->bmiHeader.biBitCount = bpp;
bmi->bmiHeader.biCompression = Bl RGB;
bmi->bmiHeader.biSizelmage = w*h*1,
bmi->bmiHeader.biCltImportant =0 ;

switch(bpp)

for(i=0 ;i< 256 ; it+)

{
bmi->bmiColors[i].rgbBlue = (char)i;
bmi->bmiColors[i].rgbGreen= (char)i;

bmi->bmiColors[i].rgbRed= (char)i;

} -
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break;
((DWORD#*) bmi->bmiColors)[0] = 0x00FF0000; /* red mask */
((DWORD#*) bmi->bmiColors)[ 1] = 0x0000FF00; /* green mask */
((DWORD*) bmi->bmiColors)[2] = 0x000000FF; /* blue mask */
break;

hBmp = ::CreateDIBSection(hDC,bmi,DIB_RGB_COLORS ,NULL,0,0);
::DeleteDC(hDC);
return hBmp;
}
2 v e W) 1 Y 3 @ ad ) 1 = Y 3 g/ 3 [
gave ldnmeonin  uddelildaiedualsinudoyanaasina Auinozdesaiedunls
g =~ ) a8 LY 4
defiudoya wwl¥dunlsuun Tassadlumanu Taslsemadaudsiuan fis
struct PixelValue {
char Red;
char Green;
char Blue;
char White;
f
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352 mIain Graphic User Interface
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Robp:Cup:2006 Project

Wideo soutce Properties
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Auto natict ml rol Robot Dialog ™
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3 ¥y 3 Vv
TUADUMIAAAT Direct SDK 1J52noud0dunoudil

1. a2l Inaa DireetX SDK (lums#inlngeld Directx SDK 9.0) v1p17n Teyed

. ¥ o_ 1 .
www.microsoft.com I.Lfsl"] AU directx sdk

Product Families
Windows
Office

A a day
2. [NAIANABINIT

Search Results
for directx sdk

Downloads i e ) e = SRR

Free Microsoft products & technologies, service packs, updates, code samples..,

# Download the DirectX Software Development Kit

Basic .NET. i l
hitp:ZAwww . microsoft.com/downloads/details . aspx?Family [d=124552FF-8363-4 7FD-8F

Kit, which contains all Dire
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3. 1@ena Inaa

Direct¥ 9.0 Software
Development Kit

Englishg E :

3171 0.3 dona1niInan iiea111nan DirectX SDK

o Al Y o
4. HAANTN 1A01nMsA Ivan

dxJsdk.exe

{ v gl ¢
sUN 0.4 madwsn 1891091298 1Maa DirectX SDK

° v e o
5. fmsvew lWanaid lvaen

WinZip Self-Extiactor = dx9sdR exel = S SN SRR |

To unzip all files in dx3sdk.exe to the specified
folder piess the Unzip button.

%

“Bun WinZip

i Unzip to folder: ——-————-l
e e T | Browses. | Close |
7 Ovemsite files without prompting " About

1

' Help

UM 05 msvorwlid dxdsdk.exe

6. @l luTramesn ldnnnsvens udandni'lvla setup.exe

setup.ese

i ¢ o
311 n.6_1vd setup.exe N1R9nn1sue1014a dxosdk.exe
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¥ ¥
7. YIINSARAININTUADY

fi& Microsoft DirectX 9.0 SDK - InstaliShield Wizard) S Bt x]

Welcome to the InstallShield Wizard for
Microsoft® Direct¥® 9.0 SDK

The InstaliShield® Wizard will install Microsoft® DirectX® 9.0
SDK on your computer, To continue, click Next.

WARNING: This program is protected by copyright law and
international treaties,

Build: 9.00.0900

| Cancel |

{i# Microsoft Direct? 9.0/5L

License Agreement

Please read the following license agreement carefully,

" '|END-USER LICENSE AGREEMENT FOR MICROSOFT SOFTWARE
DirvectX 9.0 Software Development Kit

IMF ORTANT-READ CAREFULLY: This End-User License Agreement ( ‘BEULA™) is
alegal agreement between you (either an individual ot a single entity) and Microsofit i
Corporation (“Microsoft”) for the Microsoft software that accompanies this EULA,
which includes computer soflware and may include associated media, printed
~|materials, “online” or electronic documentation, and Internet-based services

(“Software™). An amendment or addendum to this EULA may accompany the
Software. YOU AGREE TO BE BOUND BY THE TERMS OF THIS EULA BY

TR T YR SAANMIIIRTLA AT ATTIETT AT TIATRTA ST AATIITT G T S ATT

tergﬁs Eriithe’lic'énsé_agfeéﬁgﬁtf : £ i =

rms inthe license agreement




fg—,! Microsoft DirectX 9.0 SDK - InstallShield Wizard

Custom Setup

Select the program features you want installed,

Click on anicon in the list below to change how a feature is installed,

&

Instal Directx RUNine
Copy Direct¥ Setup Files
~ | DirectX Documentation
DirectX Samples and Source Code
DirectX Utilities gE
Direct® Headers and Libs ;.
| Directy Redistributable Files ‘

Install Direct% Runtime

your hard drive,

~Feature Description———————

This feature requires. 150MBon 5

- Install to:
© CHDKSDKY

Irstallahield

- Help ‘ Space l < Back

” HE@KD& Dilet:"éjj}s'[')
Runtime Installation Types

Select the type of runtime support you want installed.

DirectX Runtime Support
¢ Retail

nstalishield
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Installing Microsoft® DirectX® 9.0 SDK

The program features you selected are being installed.

._ ﬁtatu;.g' 5
 Copying new files

InstallShield Wizard Completed

The Instalishield Wizard has successfully installed Microsoft®
Direct¥® 9.0 SDK. Click Finish to exit the wizard,




(& Mictosoft DirectX 9/0/SDK - lnsia]lerffio_:_l

\  You must restart your system for the tmﬂgmatbn

changes mads ta Microsoft DirectX 9.0 50K ko taks

~ effect, Click Yes to restart now or No F you plan ko
restart later.

' 3 L
310 0.7 uaaatuneuMIAAAT DirectX SDK

) Vv
8. ¥nmsnoy'lnd BaseClass tioms 149 nudail

8.1 lalasunsy Visual C++ 6.0

3] Khan Ordre

#1 ) Logtech QuidCam

B &) ransse.l

) Mirosoft Directx 9.0 SOK

0 Mirasaft Office Tecks 1
. ; 8 MooscltVeudSarceste b

) Porosoft Visusl Studo 6.0 Erterpeise Tocls ¥

D) Moroscit Vil Studo 6.0 Tocls »

r_j Fecrosoft Web Pubdshing
Adche Acabit 6.0 Et} v 5
Prefessona ) Fegass [nagng
- ) PonerQusst Partitioniagic 8.0
[_E‘}' ey ) Pricibe Tnternet Printing
w:&uc&c!t Weud T4 4 “j geal
3 startup
ﬁg’ Piroseft visud Basd &) WinRAR
) WinZp
m Mhrosoft woed Fil Lrerhat Dicier 6 N

¥ Microsaft Visusl FoaPro 6.0
4 0 Morosoft Yisusl InterDev 6.0

Ies
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511 n.8 1ilaTisunsw Visual C++6.0

8.2 (e 'lWld BaseClasses.dsw 910 1vlaiaes C:ADXSDK\Samples\C+HDirectShow\

BaseClass

Fies of ype:  [Workspaces [dsw; mdp)

I~ Open as tead-orly

‘ﬂﬁ .9 Lfﬂﬂklﬂﬂ baseclasses.dsw
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8.2 1113 Build 919 Debug mode U Release mode

0. a3l Visual C++ I amnsaldan Direct SDK 14
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i v td
9.1 'l1)fiany Tool->Options->Directories-> Include Files i auiiuvnindagio il

C:\DXSDKMNCLUDE

C:\DXSDK\SAMPLEs\C+HDIRECTSHOW\BASECLASSESES

Oplions

Edter | Tebs | Debug | Compatibdly | Buld | Diectoies |¥(_T_E‘

Platform: Show diectories for:
O] v | [Inchuds fles ~|

;Di’ec{a‘res
D\DX'SMJ‘EELUDE o e

[ \DXSDK\SAHPLES&CH\DIHECTSHUW\BASECLASSES
C:\PROGRAM FILES\OPENCYA\CY\INCLUDE
C:APROGRAM FILES\OPENCYAOTHERLIBSAHIGHGUI
C:\Program Fres\Mictosoft Visual Studio\VCIB\NCLUDE
C:\Program Fites\Microselt Visual Sludio\VC38\MFCAIMCLUDE
C:\Prograrm Fes\Microsoft Visual Sludio\V CIS\ATLANCLUDE

l OK I Cancel

e o R, A FUR e 7 RP T Rese s e e -

ﬂﬁ .10 N5EaA Include files 14 Visual C++ 6.0

V18 o 1 el : ! : ’ Y= <
9.2 11N 9.1 lﬂ‘ﬂm‘la!' Tool->Options->Directories-> Library Files LA UWUWIIN

¥y
Fago Tl

CADXSDK\LIB

Opiluns

[wan32 | erdz; T ] ~ |
lDleciones: x 4+ %
C:ADXSDFALIR 5 2

Editor [ Tabs I Debug] Compatibty i Buld  Directories l .:
. Platforrmy Show directories foi:

C:\PROGRAM FILES\OPENCVAOTHERLIBSAHIGHGUI
C:\PROGRAM FILES\OPENCVALIB

C:\Program Fas\Microsoft Visual Studio\Y CI8\LIB
C:\Program Files\Microsoft Visual Studio\V CIB\MFCALIB
. IR

| 0K I Cancel

51 011 Msimm Library files 14 Visual C++ 6.0
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NANUIN U

MSANAWAZMNS V1M OpenCV

o ! 4
1. a1ilvaa OpenCV 71 'lad http://www.sourceforge.net/projects/opencvlibrary
Ed 1
auTunauaegli .1

Latest File Releases

Package lotes / Monitor Download
OpencCV courses & - Download
openAVYCSR-win - Download
opencv-doc Hoy Download
& C -8
betec
¥ Opency.ba..axe Ny 18532231 _ 118¢
TP batinip 4475379 44d
chopency-20030815.tar.gz 1886851 el
opencv_patch_b3_b3.1.zip 3601976 418
Location  Continent
Dublin, Ireland Europe
Keihanna, Japan Asia
- Phoenix, AZ ‘North America #1800810>
Sydney, Australia Australia 18098 Kb
‘Prague_, CzechRepublic ~ Europe 13093';'@

= 1 @
g vl duaeumsaiil lnaa OpenCV

~—
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2. i0'l81d OpenCv b3.1.exe mudliimsanddatunouaslii

43, Setup - Intel(R]) Open Source Computer Yision Libraiy: Dot s |Elﬁ]

Welcome to the Intel(R) Open
Source Computer Vision Library
Setup Wizard

This will install Intel(R) Open Source Computer Vision Library,
beta 3.1 on youwr computer.

conflicts during the installation process,

Click Mext to continue, or Cancel to exit Setup.

It is strongly recommended that you close all other applications
vou have running before continuing. This will help prevent any

46

License Agreement

i
§ Please read the following important information before continuing. (6"
E :

Please read the following License Agreement. Use the scioll bar or press the F‘age :
Down key to view the rest of the agieement.

‘; |MPORTANT: READ BEFORE DOWNLOADING, COPYING, INSTALLING OR
i USING.

f By downloading, copying, installing or using the software you agree to this license.
.|t you do not agree to this license, do not download, install,
§- copy or use the software,

Intel License Agieement
‘For Open Source Computer Vision Library

it =SS eSS s

Do ynt,i accept al the lelrhs of the preceding License Aareement? If you choose Nn

accept lhls agreemen!

2

g ~ Setupwil close. Toinstall Intel(R]) Open Source Computer Vision Libraiy. you must
:
E

o
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: 7§=tup - Intel(R]) Open Soulce mput_el Vision _ibraip“"ﬁ

i
- Select Destination Directory ﬁ
‘Where should Intel(R) Open Source Computer Vision Library be installed? ((":J.

Select lhe folder where you would like Intel(R) Dpen Source Eumputer Vision leia[_',l to
be mstalled then click Mext.

l C:AProgramme\0penCy
=

() AdTech
("] Adobe
(] Ahead
(] ArcSoft

(7 Avance Sound Manager

I =3 c: Win

The program requires at least 62,6 MB of disk space.

< Back

iter Vision Library. B oE)x
ielect Additional Tasks
Which additional tasks should be performed?

Select the additional tasks vou would Ike Setup to perform while installing Intel[FI] Dpen =

Source Computer Vision Libraty, then click Next.
¢ [7 A i <.>\OpenCVbin lo the ss*slem F'ATH E
: P 2




E‘g’?l"' - Intel{R]) Open Source Computer Yision Librajps =

Select Start Menu Folder
Where should Setup place the program'’s shortcuts?

Select the Stait Menu folder in which you would |_i_ke'Setup to cieate the program's

shortcuts, then click Next.,

OpenCy

Autostart
{Canon

CloneCD
Corel Graphics Suite 11
Microsoft Office Tools
misc
OpenCV
ScanSoft OmniPage SE
Sophos Anti-Vilus
WinZip
Zuhehnr

teady to Install

Setupis now ready to beain installing Intel(R) Open Souwrce Computer Vision
Library on your computer.

Click Install to continue with the installation, or click Back if youwant to review
change any sellings.

of _' G

Destination directory:
C:\Piogramme\OpenCy

Start Menu folder:
OpenCyY

Additional tasks:
Add <...>\DpenCV\binto the system PATH
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Setup has finished instaling Intel(R) Open Source Computer
Vision Library on your computer. The application may be
launched by selecting the installed icons.

Click Finish to exit Setup.

¥ Miew Documentatior

1 [ 8
31l v.2 TUADUNITAAAT OpenCV. b3.1.exe

[ ¥
3. 113 Build OpenCV tfon13 15911 noukn1s Build OpenCV doaiimsaana
1 £ 3
DirectX SDK Hazisnaniion1s l¥nunouud? Yuneums Build OpenCV didail
3.1 a'lda OpenCV.dsw 1nlvlames C:\Program File\OpenCV\_dsw

3.2 910115 139n Build->Batch Build->Build

4. m3mmuam Iy VisvalC++ 6.0 fioms 1491 OpenCV
4.1 MvUAn Include files

AmuanIsnAsIh 0.3



Options

Edior | Tabs | Debug | Compalibiiy | Buld Diectories | { (]3]
Platforrm: Show directories for:

¥| |inchude fles |
!_Qi:eolories: ' X+ 4
| GADXSDKAINCLUDE ~
C:ADXSDK\SAMPLES\C+ *\DIRECTSHOWABASECLASSES

C:\PROGRAM FILES\OPENCVACVAINCLUDE
C:\PROGRAM FILES\OPENCVA\OTHERLIBS\HIGHGUI
"C:\Program Fles\Microsoft Visual Studio\V CI8MNCLUDE

C:\Program Files\Microsoft Visual Studio\V CI8\MFCAINCLUDE
C:\Program Flles\Microsoft Visual Studio\VCIS\ATLAINCLUDE

i i

3N 4.3 msfhviua Include files §1%50 OpenCV

4.2 MSMAUAM library files

fruamInaagi v.4

Editor I Tabs l Debug [ Compatibility I Buld  Directories ‘{EI

_Elatform: Show dneclanesior_ _
[ Win32 aty fles

| Directaries:

I \D"(SDK\LIB—
CAPROGRAM FILES'\DPENEV\DTHEHLIBS'\HIGHEUI
C:\PROGRANM FILES\OPENCVALIB

C:\Program Files\Microsoft Visual Studio\VVCI8\LIB
C:\Program Files\Microsoft Visual Studio\V CI8\MFCALIB

[EEs)

sUN .4 Msimua Library files §1135 OpenCV




5. mstouTsunsudions 19911 Opencv

5.1 include file “cv.h, cvaux.h, highgui.h” 191311415190

J 1 {
5.2 VINWYLNS 1390 Project->Settings-> Links tab idusamaugli v.5

Project:Setlings

Seltings For: Ema? Debug
223

2)X]
Generol | Debug | C/ve] Link | Rresoue] (1])

Category. |General | Reset |

Output fla name:
: [Debugf&letenﬂamexe

Object/fbrary modules:
Ib odbeep32.lb cveamd kb vd b, highguid th, evauxd tb

V Genaiate debuainfo | loncre all default fhranes
¥ Link incrementaly [~ Genetate mapfle
I”" Enable profling
Project Options:
kemnel32.ib userd2.ib gdi32 B winspool kb o)

comdig32.kb advapi32 fb sheli32 th ole32 b
oleaut32.kb uuid Ib odbc32 kb odbocp32. b cvlib

0K | cancel |

[Win32 Retease

(R et
4 -aluluuuull

Genetal | Debug | C/C++

_i] ﬂaset[

Categoiy: [General

Oulput fte pame:
IFIeleasefStereoCamexe

Obiect/Pbiaty modules:
[ uwid.ib 0dbe32.8b odbeep32 b | v ib highgui b cvaux i

[T Generale debuginfo [ Ignote &l default Ibraties

I~ Link incrementally ™ Generate mapfie

[~ Enabls profiling

Pioject Options:

keinel32.Ib user32.kb gdi32.Ib winspool b
comd!g3?2.Ib advapi32.lb shell32.Ib ole32 kb
cleaut32.Ib uuid Bb odbc32.Ib odbeep32.ib  cv.lb,

&

I 0K I Cancel

[} 4 3} = 4
6. N3 ﬂ'lﬁuﬂ'l"l'liﬂslﬁﬂﬂij'ﬂ?lﬂﬂi

g s wamamsan msdouTilsunsuiio1d opencv

6.1 Right Click fl My Computer ->Properties

¥ o 1
6.2 NMIUNTUABUAIFLN V.6
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S

I

/7 Gtinpdioe | AuowoicUblaed[S) N _Rencts___ |

| Geneol | ComputerNeme || Haidwere | Advanced

. Visual effects, processor scheduling, memory usage, and virtual memory

¢ Startup and Recovem — il

. System startup, system failwe, and debugging information

Open

Open Command Prompt Here
Explore

Search...

Manage

B Scan for viruses...

Map MNetwork Drive. ..

Disconnect Network Drive. .

Create Shortcut
Delete
Rename

You must be logged on as an Administrator to make most of these changes.

Peifarmance —

Sellings é

User Piofiles

Desklop seltings related to your logon

P

Lo ) cos J[ o )

52




System Praperties

- User variables For wasun suriya

Variable | value ‘[
I Ci\Proaram Eiles\OpentV\bin; CI\FROIE..

| TEMP Ci\Documents and Settings\wasun suriy. ..

L TMP C:\Documents and Settings\wasun suriy...

System variables

Yariable . Malue

Com5pec C:AWINDOWSsystem32icmd.exe
FP_MO_HOST_C... NO

NUMBER_OF_P... |

05 Windows_NT |
Path C:A\WINDOWS|system32; C:\WINDOWS;... M

[ New ][ Edit ][ Delete ]

[ OK _l[ Cancel ] t
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Environment Variakies

} Edit User Variable

Variable name; ! Path I

Variable value: l Zt\Program Files\OpenG¥ibing :’kPROJECTEi
;] L Cancel ]

JC ? FRal

System variables

Variable Value

NUMBER_OF P... 1

05 Windows_NT 0
Path C\WINDOWS\system32;C:\WINDOWS;...
RPATHEXT ,COM; .EXE;.BAT;.CMD;.VBS;.YBE;.15;....

PROCESSOR_A... x86

[ wew [ edt ][ Delete ]

[ OK ][ Cancel J o1

sfi 0.6 uanamsianiPah Ifneuiames
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MANUIN A

d
T)sunsu arunuvuaue

& &
T1Jsun53 SERVO.bas 111 iiouan Iaels 1151053 MicroCode Stdio Plus PICBasic Rro 19t

nwundnlumsi@ou dsgiia.l

f # MicroCode Studio Plus - PICHasic Pro (SERYO.bas) : <A oA e [w] B3
{1 Ets E® Sesch View Hep ' '
IR | = il
(ST ss:-|pm:]ﬁ?§]§i.§; ' e

: Q Includes ' @ Robo Cup 2006 by Wasun Suriya @
| - & MODEDEFS BAS IHCLUDE "HMODEDEFS.BAS"
{7} Defines
! Py 0sC DEFINE O5C 10
|34 Constarts TRISB = %00000000
‘ TRISC = %00000000
PORTB = O
I VAR BYTE
J VAR BYTE
. CHAR VAR HORD
{| @9 Atssand Modfiel HOTOR L VAR PORTB.OD "SERVO WEEL LEFT
& moton L HOTOR_R VAR PORTB.1 "SERVO WEEL RIGHI i
+ 2 wotoR A SPD_K VAR PORTD.2 'DC SPINDLE A B
| - spoa SPD_B VAR PORTD.3 'DC SPINDLE A :
|-t} sroB HOTOR_C VAR PORTD.S 'DC CENTER ;
|~ @ mMoTOR_C HOTOR_C2 VAR PORTD,4 'DC CENTER ;
- £ MOTOR_C2 HHILE (1) '
s SERIN PORTC.7,1,CHAR '
SELECT CASE CHAR
"FORWARD T Lt W v:vavars
CASE "a"
FOR I = 1 T0 10
HIGH HOTOR R
PAUSEUS 500
il Cii |

T iPunoicdin

gﬂﬁ .1 11/51n353 MicroCode Stdio Plus PICBasic Rro




Code Program
' @ Robo Cup 2006 by Wasun Suriya @
INCLUDE "MODEDEFS.BAS" ‘include library
DEFINE OSC 10 ¢ iTHUA oscillator = 10 MHz
TRISB = %00000000 * 311157 Port B 1fluterdua
TRISC = %00000000 * (53du 1 Port C fluionvinn
I VAR BYTE * szmedauls de 1
J VAR BYTE < Uszmadauds do 1
CHAR VAR WORD * szmedauls ¥o CHAR
MOTOR_L VAR PORTB.0 'SERVO WEEL LEFT AT PORTB.0
MOTOR_R VAR PORTB.1  'SERVO WEEL RIGHT AT PORTB.1
SPD A VARPORTD.2 'DC SPINDLE A AT PORTD.2
SPD B VARPORTD.3 'DC SPINDLE A AT PORTD.3
MOTOR _C VAR PORTD.5 'DC CENTER AT PORTD.5
MOTOR_C2 VAR PORTD.4 'DC CENTER AT PORTD.4
WHILE (1) ‘gimsavianu
SERIN PORTC.7,1,CHAR ‘ﬁwf‘%’aﬂﬁ?}ammuuauﬂm
SELECT CASE CHAR
'FORWARD "
cask A" ou'ly Mt uwagaedayam wiald SERvo weines
FOR [=1TO 10
HIGH MOTOR_R
PAUSEUS 500
LV MOTOR_R
P." ISEUS 1900
DI IIMOTOR L
P 'SEUS 1900
1.V MOTOR_L

I, "'SEUS 500
NEATI
|TUI{N 1 FT 1

CASL“C
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F¢

'BAC}
CAE

(=1TO 6

I MOTOR R
'SEUS 1900
v MOTOR_R
'SEUS 500

1 MOTOR L
'SEUS 1900
v MOTOR L
ISEUS 500

I

GHT "

-

[=1TOG6

'H MOTOR R

SEUS 500
/ MOTOR_R
'SEUS 1900

1 MOTOR_L
'SEUS 500
/MOTOR_L
'SEUS 1900
[

JR e

i

[=1TO 10
1 MOTOR L
'SEUS 500

v MOTOR_L
'SEUS 1900
1 MOTOR R
'SEUS 1900

7 MOTOR_R
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I 'ISEUS 500
N Tl
'STOP 3D AND STOP KICK """
CAS '§"
1 VSPD A

1 VMOTOR_C

FEEL - \LL A
CAS N
GH SPD_A
'W SPD_B
TR | SLL W
CAS K"

GH MOTOR_C
'W MOTOR_C2
END LECT
WE®

END




MANUIN 3
1' d A lllsv
Q NIUADAT 1388
1 ;
MAad YY1 Wireless
+HV
€3
H T =Y
P
1 16 - ]- =
' —Ty
Gl 2 15 N () ~
3] aaman [ 1l g 3
o1 mae  [8] “| 3 =
] Dﬁgﬁ e 1:5 MAX2324 = -l B T =
onNeECLor - ¥ P
a1 AT 1] vyl g pos
70 o2 2 (2] o [y el 4 o
E«e i j -1 (8] o — Ar<1 (10 o
9
\-\—\3'5 | k =
A SR -
drdignall i T wistess i
dnognuin
§UN a1 udaanIndevesdeny ol Wircless
& u .
MAIV AU Wireless

Output TFusdud) vla
i 26 o1 PIC 16F877

[+

+5Y
]

7]
]

5]

514 9.2 uamamnSuvesdaya I Wircless
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MANUHIN 3

M5USUIAL Servo HotABS

miﬂ%’mwia Servo motor

MNNYUANTAYEY  Servo motor  NeARBONINNIN I5anuszansanyu lduaioe
4 " o
Uszinn 180 09 wieUszinmATaTe MY MIMsIdeen151 101 Servo motor T1) 141
o o4 g & g o My 1 = 4 o dqw
anpaziiviitluasseviufimusomld  uddvzgadonsaiuanlufesvesnsdald
° 1 { o g A 4§ @
vomo gl ludumia wie yuidesmslidae wildfifioaluSosussmsdalimyy
3 " 0 q ¥ 7 5 NYd oy
419, N uaznga i laomsvh lnwewesansanyuiluisseu ldiussdesyims
@ r My ) . by
Usuuae n3oud lu lnseadremelunidiuveswones deldun
T w9 A Q oy [ 1 k]
* MIABAMNUNTUAIN 2 A2BYNSH WNUAIATUMUYTDA 1A
o t? [l { o P o
- finguanvesunuiesiimihivgauenes (TAB STOP) 8o
« medaulasdaduniliuald (vr) Iemnsanyuldseuiinma (360°)

9

v
Hupeuaane lalil

¥ [
1. D9A¥UTIUVDY Servo motorﬂﬂmﬂuﬂ’au‘] mgﬂ’ﬂ 2.1
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LOWER CASE SCREW x4

Servo Motor f . HORS ACREW

HORN

NAME PLATE

UPPER CASE SCREW x4

UPPER CASE

GEAR-NO. 3 i

GEAR-NO, 2

MIDDLE CASE

GEAR-NO.1

POTENTIOMETER

MOTOR

Connector

-

CONTROL BOARD

LOWER CASE

v
“«y 1

317 2.1 Fudauuaz ns1sznew Servo motor
a {a o z.:iud P @ ' J a
daunundanuifles (TAB STOP) sonlasunuiliinthitesiu lilduemes i
¥y ¥ o ' b4 1
yu 180 earnisitive tostunudemonssifadunudidumuilSua 1dilosnn
v ¥ A (v alv tla g Y o & A qy s ‘ﬂ
aadunmusinlsuamld limnsonyudluaseuld deiuwielvuemeswpuily

td ]
293501 lATedosda TAB STOP luduiloandsgii 9.2




62

Remove

nouiimadiuuds

asnminsdiveas

TAB STOP

=

31 0.2 daunuin@aduiles (TAB STOP)

3. eeadimiumuliuald (vR) een udalddidmmusiianined 2 drfideeynsuiu
L | b
W i ludumbsvesdaidumulium e Tasfadwmusidamasintimnded
¥y ¥ [
szdesdimoglugag 2.2 kil 3.3 k Medliiesnindadmmusiingl fum diegluuesa

¥ o 1
ALRUVDL Servo motor HUVZFINNUMUNIL S k ATy Sedpahddunmumai

=

' o Iy Y v ya w a o =
wgeaynsunuie 19 lamanudumiulndfvesnuveudy dagii 9.3
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' 3 ~ '
nouthmalivuas |

nasmihinadivias

51 2.3 shddmmuansinaesynsy

= T o Y @ 1 Y o T A @
4. Daudiusnzanaddumuliuaivr) 0ena1neesHRINATY  IAKHBIRINIS 189N
o @ 1 dy < o T & o [ ¥
aoalddadmumulsum ldi lddluununyueewemesod  dedmmummialiumil

W o Wy o qy y P = . v ¥
i1} lummsmmmﬂmaﬁ 1 lﬂ m%n‘smmm 1‘UL‘]JﬂEJULL‘L|EN‘]_I'I\‘Jﬂ’J‘l«l“li'E)Wl‘Jﬁ'm‘l’l'm

y
= |

A Yo Y @ Ny A 0y o o

woldddmmuennsomyuseuduesld etz ldlylildavnamsnyuves
s o Y

YBIADTHIN 19 Lag

kY [
- peadudIvesAId T UA100n gl 0.4

TAB STOP

LOWER CASE

= ar

o 9 a 1 g 1 ! 3 2L | @ !
- ddwmulSum luvemesudazquiin - owezldlumiloudu  udeziindnns

e

=) w = =] P o ) = o 9 T 9 o ar 1 =1 9
@eruTavezdi uiml Mimihangamsnyuvesdadiumueyg isnhmsdadiutiosnuan

a [T @ v g o W
nanosyuunuvasdadumlium  Saunsonyuseuduedld  Ahmsdssnouds

v

- 1 ar W vd o ' = I
dumudh PAimdiowdy udddampuiiunssen bildnTdissanghiludiula
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]

Ao o v Y oA dq ¥ A o vy ny '
fdasvavnsmamgpveadidumueg diewunliieeen nie hawldiaslas hidesaulen
o ar yu [] d o ] 9 Hf
sz lddadumuiing  maes 1131452 Temianmsuldeuntlasmanudiumuiion

kY 3/ [ cg
udq wennldiiluunumyuveailounniv
3 Qs = s w Y Y 1 d:l a o 9 e 9
- nnudansevuvresd umulsua  (VR) sietleaiu liliuivesdidiunu

fanan lFeatuuneisesniuny

qy T v L1 A a A . [T o 9 @

5. lszneududinag Whiwy wee ennulasasslumsdszneudadiumuilsy

v 1 | { oy

1 (VR) aslunandued Servo motor AITHINUIUTDIATIEIMYDINTITU lansves

o 3 v A ICEL = @ 2 =t A J
Wumudaoiie il ll¥eaduaaudue Tuuparesaiugu isamiluemosves

=] 1 o @

fszannsonyuiuegoy 360 senldudr uaz Tumsilldouezdedsse
A A o 1w o ™ ot o A A
Fesves Inaamiwndonuuawes  wmszmmbweowmes iy vie  onlvaahll

2‘ s o o Y a = o - A a g o ¥
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